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Chapter 1 
Introduction 

 

Read all chapters in this guide before you install or set up a new 
installation of Sage 300. 

This guide provides the information you need to: 

• Install Sage 300. 

• Set up databases for use with Sage 300. 

• Set Sage 300 security. 

• Set up Workstations to run Sage 300. 

• Activate your data for new accounting programs. 

• Configure the Sage 300 web screens. 

• Set up users and groups, and perform other administrative tasks. 

• Understand Sage 300 licensing. 

The order of topics in this self-teaching guide matches the sequence of 
tasks you would typically perform to install and set up Sage 300. 

Integration with 
Sage CRM 

To find out how to integrate Sage 300 with Sage CRM, see the Sage CRM 
Integration Guide. 

Important! This guide contains troubleshooting tips and technical information on 
configuring supported operating systems and database engines for use 
with Sage 300. However, this guide is not a replacement for a qualified 
network or database administrator. 

Depending on your purchase agreement, some features described 
in this guide may not be available in your product. 

System Requirements 
Before you can install Sage 300, your hardware and your operating 
system must be correctly configured and fully operational. 

For a complete list of hardware and operating system requirements for 
workstations and servers, see the Compatibility Guide: 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777 

https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777
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Network Configuration 
You can configure Sage 300 in a number of ways. The best configuration 
for your company depends on the number of users who need to use Sage 
300 programs and data concurrently, and your network setup. 

Each network configuration contains the following components: 

• Server — The computer that hosts the Sage 300 data, and optionally, 
Sage 300 programs. 

In a small workgroup, a workstation may act as a server, providing 
other workstations with access to Sage 300 data and programs. 

• Workstation — A computer that connects to a server to access Sage 
300 programs and/or data. A workstation may: 

− Run the Sage 300 desktop. 

− Connect to Sage 300 via an Internet browser. 

− Connect to another workstation or server using Remote Desktop 
Protocol (RDP). 

• Database Engine — The software used to create, retrieve, update, 
and delete data from a database. 

Sage 300 works with the Microsoft SQL Server database engine only. 

Refer to the System Requirements section for supported versions. 

• Sage 300 Program Files — These include: 

− The Sage 300 System Manager. 

− Accounting applications, such as Accounts Receivable and Accounts 
Payable. 

• Sage 300 Shared Data — This includes: 

− Site folder. 

− User folder. 

− Data. 

− Company folder. 

− License Files (*.lic). 

• Sage 300 Databases — In Sage 300, there are two types of 
databases: 

− The System database stores information on users, passwords, 
security groups, security settings, and currency for all the 
companies that are linked to it. 

− The Company database contains information that is shared by all 
the company’s accounting applications. This includes the company 
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profile, fiscal calendar, optional field data, tax information for both 
sales and purchases, bank information, and all the accounting data 
for the company. Each company database must be linked to a 
system database. 

Typical Network Configurations 

This section describes the most common network configurations, 
including: 

• Single computer. 

• Windows peer-to-peer network. 

• Client-server network. 

Single “Standalone” Computer 

Installing on a single computer is the simplest configuration. All 
components are installed on one computer. 

Windows Peer-to-Peer Network 

A Windows peer-to-peer network allows the server and workstations to 
share resources. This type of network is good for small workgroups, 
consisting of two to five workstations networked together using Microsoft 
Windows Network. One of the workstations acts as a server, allowing 
other computers to access data stored on its hard drive. 

If more than two users require concurrent access to Sage 300 data or 
programs, the workstation acting as the server should be dedicated. You 
may encounter performance issues if you run Sage 300 on the server at 
the same time as other users are accessing Sage 300 from their 
workstations. 
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Client-Server Network 

In a client-server configuration, Sage 300 programs and databases are on 
one or more dedicated servers. 

The optional Terminal Server may also reside on the same physical server. 

Workstations may access programs as well as data from the server(s), or 
may have Sage 300 programs installed locally for better performance. 

 

Note: On each workstation that will run Sage 300 programs locally, 
you must install System Manager and the accounting applications. 

If you use Sage 300 Intelligence Reporting, note that: 

• Databases must reside on a single server. 

• If you use a Citrix server, there are some special considerations. For 
more information, see the Sage 300 Intelligence Reporting Citrix 
Installation Guide. 
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Sage 300 Integrated with Sage CRM 

Similar to Sage 300, Sage CRM can be installed locally, or on a server, or 
be deployed on the Web. 

In the illustration below, we’ve shown the Sage 300 Web server and the 
Sage CRM Web server on separate computers. 

Note: The Sage 300 and Sage CRM Web server can reside on the 
same computer. Typically, one database server stores both the 
Sage CRM and Sage 300 data. 

Recommendation For better security and performance, do not store shared data on the Web 
server. 

For more information about integrating Sage 300 with Sage CRM, see the 
Sage CRM Integration Guide. 

 

Where To Now? 
You are now ready to install Sage 300. 





Installation and Administration Guide    2–1 

Chapter 2 
Installing Sage 300 Programs 

 

This Chapter explains how to install System Manager, Sage 300 
accounting programs, and Sage 300 Intelligence Reporting. 

Before You Begin 
Understand the 
implications for 
your chosen 
configuration 

Before proceeding, be sure you understand the different system 
configurations and their implications for installing Sage 300: 

• On a single workstation and on a network. 

• Over different operating systems. 

Use the information in Chapter 1, “Introduction,” to help you determine 
the configuration that best meets your company’s needs. 

Make sure your 
system meets 
minimum 
requirements 

Also, make sure that the computer on which you are installing Sage 300 
meets at least the minimum system requirements for the configuration 
you choose. For up-to-date information on system requirements, see the 
Compatibility Guide: 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=26
777 

If you are 
upgrading… WARNING:  If you are upgrading an existing system to the current 

version of Sage 300, use the instructions in the Sage 300 Upgrade 
Guide to prepare for and upgrade to the current version. 

Installation Considerations 

Read the following sections before you install Sage 300. 

Considerations for Installing on a Windows Peer-to-Peer Network 

Before installing or upgrading Sage 300 on a Windows Peer-to-Peer 
network, be aware of the following special considerations: 

• Each workstation must be running Windows 7 or Windows 8. 

• A maximum of five users is supported when running in a peer-to-peer 
environment. 

https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777
https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777
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• If more than two users require concurrent access to Sage 300 data or 
programs, the workstation acting as the server should be dedicated. 
You may encounter performance issues if you run Sage 300 on the 
server at the same time as other users are accessing Sage 300 from 
their workstations. 

• On the workstation that will be acting as the server, share the Sage 
300 Program and Shared Data folders, as follows: 

− Share the Program and Shared Data folders. 

− On each workstation, use Universal Naming Convention (UNC) 
paths to connect to the shared folder. For example, \\server\share. 
If you choose to map a drive letter to the shared folder on the 
server, then in the Map Network Drive window, select the 
Reconnect at Logon check box to create a persistent connection. 

Considerations for 64-bit Windows Operating Systems 

Sage 300 is a 32-bit program. When you create a data source for Sage 
300, you must use the 32-bit version of the ODBC Administrator. 

In 64-bit versions of supported Windows operating systems, you can find 
the 32-bit ODBC Administrator in the following location: 
C:\Windows\SysWOW64\odbcad32.exe. 

Considerations for Installing the Sage 300 Web Screens 

Sage 300 web screens bring the power of Sage 300 to your web browser, 
providing a browser-based interface for Sage 300, with graphical 
presentations of key financial data. 

If you intend to install the Sage 300 web screens, you must first: 

• Ensure that Microsoft’s Internet Information Services (IIS) is installed 
on the server that will host the Sage 300 web screens.  

If IIS is not installed, install it before you attempt to install the Sage 
300 web screens. 
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• When selecting Windows features, under World Wide Web Services’ 
Application Development Features, select the ASP, CGI, ISAPI 
Extensions, and ISAPI Filters options, as shown here: 

 

Using Sage 300 Sample Data 
Sage 300 comes with two sample company databases that let users 
experiment and become familiar with Sage 300 features before they work 
with your company data. The two databases are: 

• SAMINC.  A single-currency database for a US company named 
Sample Company Inc. It uses the US Payroll program. 

• SAMLTD.  A multicurrency database for a Canadian Company named 
Sample Company Ltd. It uses the Canadian Payroll program. 

Both databases contain data for the following accounting modules: 

• General Ledger 
• Accounts Receivable 
• Accounts Payable 
• Inventory Control 
• Order Entry 
• Purchase Orders 
• Payroll (US or Canadian) 
• Project and Job Costing 

You can choose to install sample data when you install Sage 300. 

Note:  If you use Sage 300 Intelligence Reporting, sample data is 
required for demonstration reports. 
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Installing Sage 300 
You install Sage 300 System Manager, System Manager Components, and 
all Sage 300 accounting applications in one continuous process, consisting 
of two phases: 

1. Installing the programs. 

2. Entering license information (unless you have already installed licenses 
for this version). 

Installing the Programs 

1. Download Sage 300, and then double-click the ISO file. 

If the installation screen does not appear automatically, go to the root 
directory (for example, d:\), and run AUTORUN.EXE. 

A screen may appear prompting you to install one or more programs 
and tools that are required by Sage 300. 

2. On the installation screen, click View Pre-Installation Checklist. Print a 
copy of the checklist and follow all steps before you continue. 

3. On the installation screen, click Sage 300. 

4. On the Sage 300 installation screen, click Sage 300. 

5. On the Welcome screen, click Next. 

6. Click the option to accept the license agreement, and then click Next. 

7. Select the geographical region where you are installing the software, 
and then click Next. 

8. For the client information, enter your 7-digit or 10-digit client ID and 
the company name to use for registration, and then click Next. 

9. For the optional information, enter a contact person, your dealer, and 
certified consultant, and then click Next. 

10. Select the edition of Sage 300 you require, and then click Next. 

11. Specify the names and locations of your program and data folders, and 
then click Next. 

Note:  To use web screens, you must specify the full path for the 
shared data folder (do not specify a mapped drive) and a local path 
for the programs folder (do not specify a mapped drive or a UNC 
path). 
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12. On the Select Features screen, select features and applications to 
install, and then click Next. 

Program 
dependencies 

Most of the applications require you to install others, and all of them 
require core System Manager files. The following list shows any 
additional requirements in parentheses for each application: 

• Bank Services (requires Tax Services, G/L Subledger Services). 

• Accounts Payable (requires Bank Services, Tax Services, G/L 
Subledger Services). 

• Accounts Receivable (requires Bank Services, Tax Services, 
G/L Subledger Services). 

• Inventory Control (requires G/L Subledger Services). 

• Order Entry (requires Accounts Receivable, Inventory Control, Tax 
Services). 

• Purchase Orders (requires Accounts Payable, Inventory Control, 
Tax Services). 

• Project and Job Costing (requires G/L Subledger Services, Accounts 
Payable, Accounts Receivable, Tax Services). 

• G/L Consolidations (requires General Ledger). 

• Intercompany Transactions (requires General Ledger). 

• Sage Intelligence Reporting (requires the Financials Suite). 

• Payment Processing (requires Accounts Receivable, Order Entry, 
and Sage Exchange). 

13. On the next screen, in the Program Folder field, type the location on 
the Start menu where you want Sage 300 to appear, then click Next. 

14. Click Install. 

Enter activation 
codes  

Once installation has finished, the Sage 300 License Manager appears if 
you have not already installed licenses for this version. Follow the 
instructions in the next section to enter license information. 
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Entering License Information 

In the Sage 300 License Manager, the License Information tab shows 
information entered during installation: 

Note:  Do not change the company name unless you need to 
change the business entity to which the programs are registered. 

If you change the company name, the licenses will appear 
Unauthorized, until you apply for and enter new activation codes. 

The process for entering Sage 300 license information differs depending 
on whether you have a subscription license or a perpetual license. 

To enter Sage 300 subscription license information: 

1. On the License Information tab, enter your serial number. 

2. Click Refresh. 

Required license information such as activation codes and expiry dates 
is automatically entered or updated. 

3. Click Close. 

4. Click Finish to close the Installation wizard. 

To enter Sage 300 perpetual license information: 

1. If you have activation codes for your Sage 300 programs, click the 
Licenses tab, then, for each Sage 300 program: 

a. Double-click in the Serial Number column, and then enter the serial 
number. 

b. Double-click in the Activation Code column, and then enter the 
activation code. 

If you don’t yet have activation codes, you can use the 30-day 
temporary licenses created during installation, and enter the 
permanent code later, as described in Chapter 7, “Licensing Sage 
300.” 

2. If you installed Analysis Connector modules for Sage 300 Intelligence 
Reporting, enter their activation codes on the Licenses tab. 

Note:  The Report Manager, Report Viewer, Analysis, and Connector 
programs are not available with a 30-day license. You must have a 
permanent license to use them. (Sage 300 comes with one free 
Report Manager license.) 
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3. Click the Users tab. 

Note: The system allows you to register only one LanPak license. If 
a temporary LanPak license exists for this version, skip to step c, 
and then follow the remaining instructions to enter your permanent 
registration on the existing line.  

a. Right-click the grid, and then select Insert from the menu that 
appears. The new entry shows your current Sage 300 version and 
edition.  

b. In the new line, double-click the License Type column, and then 
select LanPak from the list.  

Do not select a database-specific entry!  

c. Double-click in the Count column, and then type the total number 
of users who require Sage 300 access for this installation. (The 
count is the sum of existing users plus the new users for whom 
you’re adding LanPak licenses.) 

If you have a permanent license for this version, and you are asked 
if you want to overwrite the existing license, click Yes. 

The system immediately deletes any existing LanPak licenses.  

d. Double-click in the Serial Number column, and then type the 
LanPak serial number that Sage provided.  

e. Double-click in the Activation Code column, and then type the 
activation code that Sage provided. 

If you don’t yet have an activation code, you can create a 
temporary license by leaving the activation code blank.  

f. Press Tab, or click elsewhere on the grid, to leave the field.  

The system changes the Count to the purchased amount (if 
necessary) and enters Activated in the Activation Code field. 

LanPak 
IMPORTANT:  You must record at least one LanPak license to use 
Sage 300.  

For Sage 300 Intelligence Reporting, one Report Manager license for 
one user is free with Sage 300. If you have additional licenses for 
Report Manager and Report Viewer, enter their activation codes in the 
Activation Code column. 

4. Click Close. 

5. Click Finish to close the Installation wizard. 
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Setting Up Workstations 

Workstation Setup Utility 

The Workstation Setup utility is a component of the System Manager 
installation. It installs the components that a workstation requires to run 
System Manager and accounting modules on a server. 

You must run Workstation Setup on each workstation that will run Sage 
300 programs from a server. 

Note:  You do not need to run Workstation Setup on a workstation 
to use the Sage 300 web screens. 

Do not run Workstation Setup if: 

• The workstation will run Sage 300 programs locally. 

In this case, install Sage 300 System Manager and the accounting 
applications on the workstation, as described earlier in this chapter. 

• The workstation is using Remote Desktop Protocols (RDP) to remotely 
control another workstation or server. 

In this case, install Remote Desktop Client on your remote computer. 
Then, connect through a Terminal Server or directly to a workstation 
or server that is configured for remote access. 

Note: This guide does not include instructions for setting up 
terminal services or RDP. Talk to your network administrator about 
this option. 

Setting Up a Workstation 

1. Share your Sage 300 program folder, with at least the following 
permissions for users: 

− Read 

− Read and Execute 

2. Share your Sage 300 data folder, with Full Control permission for 
users. 

3. Create your system and company databases. For more information, 
see Chapter 3, “Database Setup.” 
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4. On the workstation, run the Workstation Setup utility: 

a. Locate the setup.exe file for the utility. By default, it is in the Sage 
300 program folder on the server where you installed Sage 300: 
\\<server>\<program folder>\WSSetup\setup.exe 

b. Right-click setup.exe, and then click Run As Administrator. 

5. Enter the paths for your shared program folder and data folder. 

Running Sage 300 Intelligence Reporting for the 
First Time 

The first time you run Sage 300 Intelligence Reporting, you must log in as 
the Windows administrator. 

A user with Windows administrator privileges must register the ActiveX 
component, BICore.exe, that Intelligence Reporting requires. To register 
this component, open any Sage 300 Intelligence Reporting form. Once the 
component is registered, other types of users can open these forms. 

If you use workstation setup, you must also run Sage 300 Intelligence 
Reporting workstation setup (located in BX66A\WSSetup) on every 
workstation where you will view and use Intelligence Reporting screens. 

Where To Now? 
New installation If you are installing Sage 300 for the first time, you must create and set 

up system and company databases.  

If you plan to use the Sage 300 web screens, you must also create a 
portal database. 

For information on setting up databases for Sage 300, see Chapter 3, 
“Database Setup.” 

Activating data Once you have set up company and system databases, you can activate 
your data for the current version, as described in Chapter 4, “Activating 
Sage 300.” 

Configuring the 
web screens 

If you installed the Sage 300 web screens, you need to configure them to 
connect them to the portal database. 

For information about configuring the Sage 300 web screens, see 
Chapter 5, “Configuring Sage 300 Web Screens.” 



Where To Now? 

2–10    Sage 300 

Grace period for 
temporary licenses 

You can use temporary licenses for 30 days while you wait for your 
activation codes. However, you must enter activation codes before the 
grace period ends, or you will no longer have access to Sage 300. 

For instructions on updating your licenses, see Chapter 7, “Licensing Sage 
300.” 

Upgrading an 
existing system 

If you are upgrading an existing system, refer to the Sage 300 Upgrade 
Guide for steps on activating your data and for important information 
about the conversion of your data, including additional steps you may 
need to take before and after activation. 
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Chapter 3 
Database Setup 

 

In this chapter, you’ll learn how to create your Sage 300 system, 
company, and portal databases, and how to set global security options. 

This chapter does not provide detailed instructions on how to install or 
configure database software. See your database or network administrator 
for detailed instructions and support. 

To get the most recent list of supported database versions, see the 
Compatibility Guide: 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=26
777 

Overview of Database Setup 
Before you can create a company in Sage 300, you must create system 
and company databases using Microsoft SQL Server. 

Portal database If you plan to use the Sage 300 web screens, you must also create a 
portal database in Microsoft SQL format. Normally, you create the portal 
database on the same server as your company database. 

After creating the databases using your database software, you use the 
Database Setup utility to set up the databases for Sage 300. 

Creating System, Company, and Portal Databases 
In Sage 300, there are three types of databases: 

• System Database. Stores information on users, passwords, security 
groups, security settings, and currency for all the companies that are 
linked to it. You must create a system database before creating a 
company database. 

• Company Database. Contains information that is shared by all the 
company’s accounting applications. This includes the company profile, 
fiscal calendar, optional field data, tax information for both sales and 
purchases, bank information, and all the accounting data for the 
company. Each company database must be linked to a system 
database. Multiple company databases can be linked to the same 
system database. 

https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777
https://support.na.sage.com/selfservice/viewdocument.do?externalId=26777
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• Portal Database. The portal database stores files used by the 
Sage 300 web screens.  

The portal database is shared by all companies in a Sage 300 
installation, so you set up only one portal database. 

Database ID Sage 300 uses a Database ID to identify databases. Each ID is a unique 
code of uppercase characters, consisting of letters from A to Z, or 
numbers from 0 to 9, or any combination of letters and numbers. 

Note:  The ID for system and company databases cannot be more 
than six characters long. This restriction does not apply to portal 
database IDs. 

For simplicity, we recommend that the Database ID, the database, the 
folder for the database, and the Data Source Name (DSN) be identical. 

The sections that follow provide instructions for creating system, 
company, and portal databases. 

Creating Microsoft SQL Server Databases 

Creating Databases in SQL Server Management Studio 

1. On the server, On Windows’ Start menu, select Programs > Microsoft 
SQL Server <version> > SQL Server Management Studio. 

The Connect to Server screen appears. 

2. For Server type, select Database Engine. 

3. Accept the Server name that is displayed (the name of the computer 
you are currently working on). 

4. For Authentication, we recommend that you use SQL Server 
Authentication. 

Important!  You must use SQL Server authentication for the portal database. 

Type in the database administrator’s Login name and Password. 

5. Click Connect to open SQL Server Management Studio. 

6. In the Object Explorer panel, expand the folder tree for the SQL 
Server, and then expand the Databases folder tree. 

7. Right-click Databases, and then select New Database… from the menu. 
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The New Database window appears, as follows: 

 

8. In the Database name field, type the 6-character name for the system 
database. 

9. In the Database files section: 

a. In the Initial Size column, specify the amount of disk space that 
SQL Server will initially reserve for the Sage 300 database. For new 
databases, use the default value. 

b. In the Autogrowth column, you can select whether the container 
grows by a fixed percentage or by a fixed amount of disk. For new 
databases, use the default value. 

10. In the left pane, click Options. 
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a. For English-language support, use Latin1_general_bin or 
Latin1_general_ci_as the collation method. 

Collation method We recommend that you use a binary collation method, such as 
Latin1_general_bin. 

b.  For Recovery Model, select Full.   

11. Click OK. 

Extended 
Properties Warning: If you are setting extended properties for your database, 

make sure you do not turn on the XACT_ABORT property. This 
feature is not supported by Sage 300. 

12. Repeat steps 7 to 11 to create your company database. In step 8, type 
the 6-character name for the company database. 

13. Repeat steps 7 to 11 to create your portal database. In step 8, type 
the 6-character name for the portal database. (We recommend using 
PORTAL as the name of your portal database.) 

Creating and Assigning Database Rights to a SQL Login ID 

A SQL Login ID is required to log in to a Sage 300 database. The ID is not 
revealed to users; Sage 300 uses this ID internally when it connects a 
user to the SQL Server.  

Important!  To improve the security of your system, you should use 
a different SQL Login ID for the portal database than the SQL Login 
ID specified for system and company databases. 
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1. In SQL Management Server Studio, in the left-side Object Explorer 
panel, expand the Security folder.  

2. Right-click Logins and then click New Login… from the right-click 
menu.  

The New Login form appears, as follows: 

 

3. In the Login name field, type a name for your new SQL Login ID.  

4. Select SQL Server Authentication, and then type in a password, and 
confirm it.  

5. Click OK to save your changes. 

In the Object Explorer, your new Login name appears within the 
Logins folder.  

6. Assign database rights to the new SQL Login ID. 

a. In the Object Explorer, expand the Logins folder, and then double-
click the new Login name you created.  

The Login Properties form appears. 

b. In the left pane, click Server Role, and in the right pane, select 
sysadmin. 

c. In the left pane, click User Mapping.  

d. In the Database column, select the system and company databases 
you created. 

e. Under Database role membership for, select db_owner. 

f. Click OK to save your changes. 
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Creating ODBC Connections on Client Workstations 

If you are using a DSN to connect to your SQL databases on the server, 
on all client workstations, create an ODBC connection to your databases. 

Important! If you do not create a Data Source (DSN) to connect to your databases, 
Sage 300 can connect to the SQL Server directly using the server name 
and default settings. 

1. Open the ODBC Data Source Administrator. 

Sage 300 is a 32-bit application. When you create a data source for 
Sage 300, you must use the 32-bit version of the ODBC Administrator.  

In 64-bit versions of supported Windows operating systems, you can 
find the 32-bit ODBC Administrator in the following location: 
C:\Windows\SysWOW64\odbcad32.exe. 

  

2. Select the System DSN tab, and then click Add. 

The Create New Data Source form appears: 
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3. Select SQL Server Native Client 11, and then click Finish.  

The Create A New Data Source To SQL Server form appears:  

 

4. Enter the following information for the Data Source: 

a. In the Name field, type the 6-character name of the system 
database.  

b. Type an optional description.  

c. Select the database server from the list.  

Note:  When creating the DSN for a portal database, if you specify 
a named instance of SQL Server, be sure to append the database 
port number. For example, specify SERVER\INSTANCE,1433. (If 
you use a nonstandard port, specify that number instead of 1433.) 

5. Click Next. The following form appears: 
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6. Enter authentication information: 

a. Select SQL Server authentication. 

b. Select Connect To SQL Server To Obtain Default Settings For The 
Additional Configuration Options.  

c. In the Login ID field, type in the SQL Login ID and password that 
you created in the previous section.   

7. Click Next.  

The following form appears: 

 

8. Select the option Change The Default Database To, and then select 
Database For This Connection. Leave the other fields at their default 
values.  

9. Click Next, and then Finish to create the ODBC data source.  

10. Click Test Data Source to test the connection to the database.  

Where To Now?  

Now that you have created system and company databases in your 
database management system, you need to set them up for use with 
Sage 300, as described in the section “Setting Up Company and System 
Databases,” later in this chapter. 

If you set up a portal database, you need to configure it, as described in 
Chapter 5, “Configuring Sage 300 Web Screens.” 
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Setting Up Company and System Databases 
Use the Sage 300 Database Setup utility to configure your system and 
company databases for use with Sage 300. The Database Setup utility is 
installed with Sage 300 System Manager. 

Important! Only the Sage 300 ADMIN user can use the Sage 300 Database Setup 
utility, which allows the ADMIN user to: 

• Add, edit, and delete system and company databases. 

• Configure the Sage 300 web screens. 

• Turn on security for a system database. 

• Select advanced security settings, such as password options, that 
apply to all users. 

Setting Up a System Database 

1. On the server, On Windows’ Start menu select All Programs > 
Sage 300 > Database Setup. 

The Sign-on form appears:  

 

2. Sign in using the administrator (ADMIN) password.  

Note:  The default password is “admin.” 

Change ADMIN 
password  

After creating your databases and activating your applications, 
change the ADMIN password to prevent unauthorized use of 
Sage 300. It is important that other users do not have access to the 
system administrator’s tasks. 
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The Database Setup form appears: 

 

Note:  What you see may be different, depending on whether 
sample data was installed, whether other Sage 300 databases have 
already been created, and whether company colors have been 
assigned. 

3. Click New, or press the Insert key. 

The New Database form appears: 

 

4. In the Database ID field, enter the name of the DSN you created for 
the system database.  

Note:  The Database ID always defaults to uppercase, and cannot 
be changed after it is assigned. 

5. For Database Category, select System. 

6. Click OK. 
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7. Fill in the fields on the Edit Database Profile form that appears: 

 

a. In the Description field, type a description for the database, using 
up to 60 characters. The Database ID is displayed by default. 

b. Click the Data Source option, and then select the data source name 
from the Data Source field, or specify the server name for the 
database in the Server field. (Only data sources you created on 
your workstation appear in the list.) 

Note that the names of the data sources must be consistent on all 
workstations that use the same shared Data directories. 
Remember, also, to type the name with the same capitalization 
that you used to define it with the ODBC Administrator. 

c. Enter the SQL Login ID that you created for all Sage 300 users.  

Warning Make sure you enter the SQL Login ID correctly because you will 
not be able to change it after you save the database profile. 

d. Enter the Password for the Login ID you entered in the previous 
field. 

When users sign on to Sage 300, the System Manager verifies their 
Sage 300 passwords, then logs onto SQL Server using the Login ID 
and password specified here. Individual Sage 300 users do not 
need Login IDs for SQL Server. 

e. Enter the name of the database you created as the Sage 300 
system database. Make sure you use the same capitalization that 
you did when you defined it with the SQL Enterprise Manager. 
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f. If you intend to limit user access to accounting data, select the 
Enable Application Security option. (You can select this option only 
for system databases, not for company databases.) 

With security on, all access to application windows is then 
controlled by Sage 300’s own security system. With security off, 
Sage 300 still uses the SQL Server Login ID and Password to gain 
access to the database, but it doesn’t restrict access to Sage 300 
users. 

g. Click OK. 

Assigning Company Colors 

If you use Sage 300 to manage multiple companies, you can assign a 
unique color to each company. This color appears in a border around Sage 
300 forms, making it easier to see which company's information you are 
viewing and avoid data entry errors. 

Colors assigned to companies appear on the Database Setup form: 

 

To assign colors to companies, select the Assign Colors Automatically 
option. Sage 300 assigns default colors to all companies for which you 
have set up databases. 

You can assign colors to all companies, or to as few or as many companies 
as you like.  

On the Edit Database Profile form, you can change the color assigned to a 
specific company, or turn off the company color option for that company.  

If you want to clear all colors, click the Clear All Colors button on the 
Database Setup form. 
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Setting Up a Company Database 

1. If Database Setup is not already running, On Windows’ Start menu, 
select Programs > Sage 300 > Database Setup. 

2. Sign in using the administrator (ADMIN) password.  

The Database Setup form appears: 

 

Note:  What you see may be different, depending on whether 
sample data was installed, whether other Sage 300 databases have 
already been created, and whether company colors have been 
assigned. 

3. Click New, or press the Insert key. 

The New Database form appears: 
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4. In the Database ID field, enter the name of the DSN you created for 
the company database.  

Note:  The Database ID always defaults to uppercase, and cannot 
be changed after it is assigned. 

5. For Database Category, select Company. 

Note:  For company databases, the Database ID will appear in the 
title bar of windows that contain company data, such as Company 
Profile, Fiscal Calendar, and Optional Tables. 

6. Select the system database ID you created earlier. 

7. Click OK. 

8. Fill in the fields on the Edit Database Profile form that appears: 

 

a. In the Description field, type a description for the database, using 
up to 60 characters. The Database ID is displayed by default. 
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b. Click the Data Source option, and then select the data source name 
from the Data Source field, or specify the server name for the 
database in the Server field. (Only data sources you created on 
your workstation appear in the list.) 

Note that the names of the data sources must be consistent on all 
workstations that use the same shared Data directories. 
Remember, also, to type the name with the same capitalization 
that you used to define it with the ODBC Administrator. 

c. Enter the SQL Login ID that you created for all Sage 300 users.  

Warning Make sure you enter the SQL Login ID correctly because you will 
not be able to change it after you save the database profile. 

d. Enter the Password for the Login ID you entered in the previous 
field. 

e. Enter the name of the database you created as the Sage 300 
company database. Make sure you use the same capitalization that 
you did when you defined it with the SQL Enterprise Manager. 

f. If you want to assign a color to the company, click the Select Color 
button, and then select a color. This color appears in a border 
around Sage 300 screens when you sign in to this company, 
making it easier to see which company’s information you are 
viewing and avoid data entry errors. 

g. Click OK.  

9. Click Exit to close Database Setup. 

Setting Global Security Options 
The Sage 300 System Administrator can set advanced global security 
options, such as the length of passwords and how often they should 
change.  

The options you set affect both company and system databases. 

To set global security options: 

1. If Database Setup is not already running, On Windows’ Start menu, 
select Programs > Sage 300 > Database Setup. 

2. Sign in as ADMIN, and then click OK to open the Database Setup form. 

The Database Setup form lists the system and company databases 
that have been created. 
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3. Click the Security button. 

The Advanced Security Settings form appears: 

 

4. Select the following options as needed.  

Important! Selections will apply to all Sage 300 databases listed on the Database 
Setup form.  

If application security is not turned on for your system database, or if 
it is turned on but no password is required, the password settings on 
the Advanced Security Settings form have no effect. 

Require complex passwords.  If a user enters a password that does 
not include both letters and numbers, a “Password change is required” 
message appears. When the user clicks OK, the Change Password form 
opens. 

Require passwords to change every [   ] days.  Requires users to 
change their passwords after a specified number of days. Enter a value 
from 1 to 999.  

Expired passwords If a password expires, users will receive a message that it has expired, 
and the Change Password form will open. 

Require minimum password length of [ ] characters.  Requires 
users to create passwords of a set length. Enter a value between 4 and 
64 characters. If users enter a shorter password, they will receive the 
message, “Password change is required.” When they click OK, the 
Change Password form opens. 
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Lock out user after [ ] attempts.  Enter the number of times a user 
can enter an invalid password before they are locked out of the 
system. When a user is locked out, they can wait for the lockout 
period to expire before attempting to log in again, or the System 
Administrator can clear the option, allowing the user to attempt to log 
in again.  

Enable locked-out user after [ ] minutes.  Enter the number of 
minutes between 1 and 30,000 in which a locked-out user can retry 
their password. 

Use time server. Synchronize you workstation’s time with a specified 
server. 

Note:  If you restrict the hours a user can sign in to Sage 300, it is 
important to use a time server to maintain this security.  

5. Click OK to save your changes and return to the Database Setup form. 

6. Click Exit to close Database Setup. 

Setting Up Transparent Data Encryption (TDE)  
If TDE is set up on your database server, you can enable TDE on 
databases (using SQL Server Management Studio). 

Notes: 

• TDE is available in only some versions of Microsoft SQL Server. 

• TDE is only one element of securing your Sage 300 system. 

• Enabling TDE may affect the performance of Sage 300. 

To enable TDE on a database: 

1. In SQL Server Management Studio, right-click a database, and then 
click New Query on the menu that appears. 

The New Query screen appears. 

2. Enter the following command: 

ALTER DATABASE <database name> SET ENCRYPTION ON 

3. Click Execute. 
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Where To Now? 
You can now sign on to your new company, create the company profile, 
and activate your data for the current version. 

For information about activating your data, see Chapter 4, “Activating 
Sage 300.” 

If you set up a portal database (recall that you must use Microsoft SQL 
Server — Express or full Edition, to create your portal database), you need 
to configure it, as described in Chapter 5, “Configuring Sage 300 Web 
Screens.” 
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Chapter 4 
Activating Sage 300 

 

Before you can use a new company or a new accounting application, you 
must prepare your database for use with Sage 300. This process is called 
activation. 

This chapter describes activation and gives instructions for: 

• Signing on to a new company.  

• Creating the company profile.  

• Activating your data for new accounting programs.  

If you are 
upgrading from an 
earlier version… 

If you are upgrading from an earlier version of Sage 300, you should refer 
to the Sage 300 Upgrade Guide, which provides specific instructions for 
installing programs and activating data for existing Sage 300 systems. 
You may need to perform additional procedures in a certain sequence 
when upgrading from previous versions. Also, when you are upgrading, 
you don’t need to perform some of the steps that are required for new 
installations. 

Set up system and 
company 
databases, first 

You must create system and company databases using your database 
software before you can set up the databases for use with Sage 300. The 
instructions in this chapter assume that you have created a system 
database and a company database for the database engine you are using 
with Sage 300. For information on setting up databases, see Chapter 3, 
“Database Setup.” 

Before You Begin 
When you start Sage 300 with a new company database, you will need to 
specify: 

Number of periods 
in the fiscal 
calendar 

• The number of fiscal periods your company uses. 

Decide whether to use 12 or 13 periods in your fiscal year.  

If you use 13 periods, decide which quarter will contain four fiscal 
periods. 

Functional currency • Your company’s functional currency — that is, the currency in which 
your company keeps its books. 
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The functional currency applies to all Sage 300 applications for the 
company (such as Accounts Receivable, Accounts Payable, and 
Payroll). 

If you use multicurrency accounting, you must also specify: 

Default rate type  − A default exchange rate type (for example, monthly average rate 
or daily spot rate). 

Determine the rate type your company uses most often to convert 
amounts entered in another currency to the functional currency 

− Your reporting currency, if the euro is your functional currency, and 
you want to produce reports in both euro and your national 
currency. 

You must use the 
Sage 300 Desktop 
to activate 
programs 

Note:  You must use the Desktop to activate all Sage 300 programs. 
You cannot activate programs in the Sage 300 web screens. 

Signing On to a New Company 
New company When you sign on to a company, Sage 300 checks whether Administrative 

Services and Common Services for the company are activated.  

• If this is the first time you are using a new system database, Sage 300 
prompts you to activate Administrative Services. The activation 
process creates currency and security tables, installs standard 
currency codes and rate types, and places the Administrative Services 
icon on the Sage 300 desktop.  

• The first time you open a new company, Sage 300 prompts you to 
activate Common Services. When you activate Common Services, the 
program creates tables to store company-wide information, displays 
the Company Profile, and places the Common Services icon on the 
Sage 300 desktop. 

To sign on to a new company: 

1. From the Windows Start menu, select All Programs > Sage 300 > 
Sage 300. The Open Company form appears. 

 



Signing On to a New Company 

Installation and Administration Guide    4–3 

Sign on with the 
ADMIN user ID 

2. In the User ID field, type ADMIN. This is the ID for the system 
administrator, the only person authorized to set up a new company.  

 3. If you selected the option Enable Application Security when you set up 
the system database, enter the system administrator’s password. 

Company 4. From the Company list, select the name of the new company. 

The list contains the names of all company databases you created for 
Sage 300, as well as the names of sample companies, if you installed 
sample data. 

Session date 5. In the Session Date field, type the date of your work session (or accept 
the default). This date will be the default Fiscal Year Starting Date 
when you activate Common Services for the company.  

If the system database is being used for the first time, the following 
form appears: 

 

6. Click Proceed to activate Administrative Services for the system 
database.  

The program displays messages showing that data is being activated. 

Once Administrative Services has been created and initialized, the 
program prompts you to enter the company’s fiscal year starting date 
and proceed to activate Common Services, as shown here: 

 

7. Type the starting date of your company’s current fiscal year in the 
Fiscal Year Starting Date field, if it is different than the default date. 
Sage 300 creates this fiscal year in your company calendar. 

8. Click Proceed to activate Common Services for the company database. 
Messages appear showing that tables are being created. 
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9. After Common Services has been created and initialized, the Common 
Services Activation form appears, as follows: 

 

The options on the Common Services Activation form belong to your 
Company Profile. Follow the instructions in the next section to 
complete the company profile.  

If you click Cancel, you return to the Open Company form. When you 
next start Sage 300 for this company, you are asked to activate 
Common Services. 

10. When you are satisfied with the company profile information, click OK. 

Sage 300 places icons for Administrative Services and Common 
Services on the company desktop. 

Creating the Company Profile 
This section describes the company profile information you enter when 
you open a new company, such as the address and options for all the 
Sage 300 applications used by your company. The Common Services 
Activation form includes the following tabs: 

• Address.  Displays the database ID and the name of the company you 
selected when you signed on. It includes fields for the address, 
telephone and fax numbers, and contact name.   

• Options.  Contains fields for company-wide settings, such as the 
number of fiscal periods in your fiscal year, and whether you use 
multicurrency accounting.  
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Entering Company Information 

1. Fill in the fields on the Address tab, as follows: 

You can change 
defaulted contact 
information in 
subledgers 

The address information you enter on this page also appears as the 
default in the Options form for each accounting application. You can 
change the contact, phone number, or fax number to identify a 
person or position in the company for whom you are creating a 
specific ledger system. 

Doing Business As.  Type the company’s name, exactly as you want 
it to be on all reports, financial statements, customer statements, and 
invoices. You can use up to 60 characters, including letters, digits, 
symbols, and punctuation. The default entry is the description from 
Database Setup.   

Legal Name.  Type the company’s legal name, if it is different from 
the business name.   

Address.  Type the company’s address. 

City.  Type the name of the city where the company is located. 

State/Province.  Type the name of the state or province where the 
company is located. 

Zip/Postal Code.  Type the company’s zip or postal code. 

Country.  Type the name of the country where the company is 
located. 

Contact.  Type the name of a general contact person or position in the 
company.  

Format Phone Number.  Select this option if the company’s phone 
and fax numbers are 10 digits long and are formatted with standard 
parentheses and hyphens, for example (555) 982-9800. Don’t select 
the option if you use longer phone and fax numbers, or you need 
additional punctuation. 

Telephone / Fax Number.  Type the company’s telephone and fax 
numbers. 

Except for the database ID, you can change any of the entries on this 
tab at any time. 

2. Fill in the fields on the Options tab, as follows: 

Number of Fiscal Periods.  In most cases, you select 12 periods if 
your fiscal year is divided into calendar months, and 13 if your fiscal 
year is divided into four-week periods.  
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Changing fiscal 
periods later not 
recommended  

IMPORTANT:  If you change the number of fiscal periods, later, you 
will not be able to compare amounts between years that have 
different numbers of fiscal periods. 

Editing fiscal 
periods 

The number of fiscal periods you select determines the lengths of the 
default periods on the fiscal calendar. If your fiscal periods vary in 
length, or if you have a 12-period fiscal year, which does not start on 
the first day of the month, you need to edit the dates in the Fiscal 
Calendar form after you create the company profile. 

Quarter with 4 Periods.  If you use a 13-period ledger, select the 
quarter that contains four fiscal periods, rather than three. Note that 
you can change this quarter later, although if you do, your previously 
printed reports may not be consistent with data printed after the 
change.  

Locked Fiscal Period.  Select None, Warning, or Error from the list. If 
you select Error, subledgers and Bank Services prohibit transactions 
from being entered or posted to a period that is locked. 

Note:  This option does not affect posting in General Ledger. If a 
fiscal period is locked for General Ledger, users can’t post 
transactions to that period, regardless of your selection for option.  

Warning Date Range.  If you want to be warned when you enter a 
date for a transaction that is more than a specified number of days 
before or after the session date, type the number of days. If you want 
to be warned less often, type a large number (up to three characters).  

Inactive G/L Account.  Select None, Warning, or Error from the list. 
If you select Error, subledgers and Bank Services prohibit entries to a 
General Ledger account that has been flagged as Inactive. 

Non-existent G/L Account.  Select None, Warning, or Error from the 
list. If you select Error, subledgers and Bank Services prohibit entries 
to an account number that does not exist. 

Value Added Tax Location Type and Location Code.  This information is used in 
countries, such as the United Kingdom, where a Value Added Tax 
(VAT) is calculated and reported. If your company reports VAT, type a 
six-character code for location type and up to 30 characters for the 
location code. 

Country Code and Branch.  You can type six-character codes for 
country and branch.  

 
Multicurrency 
ledgers 

Multicurrency.  Select this option if you will enter, retrieve, import, 
post, and report transactions in more than one currency.  
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You cannot change 
multicurrency Note:  If you don’t select the multicurrency option during Common 

Services activation, you can select it later. However, once you 
select the multicurrency option and save the company profile you 
cannot change the option. 

Functional Currency.  Whether you use multicurrency or not, you 
must enter a functional currency. 

To select from the list of supplied codes, click the Finder beside the 
Functional Currency field, then double-click the code for your currency. 

If your company maintains its books in the currency of a participating 
country of the European Monetary Union (EMU), you must select EUR 
as your functional currency code. 

If the code for your functional currency is not in the list, click the New 
icon beside the Finder, and then enter the international code for your 
currency.  

You cannot change 
the functional 
currency 

Note:  You cannot change the functional currency code after you 
save the company profile. 

3. If you selected the Multicurrency option, fill in the following fields that 
appear on the Options tab: 

Default Rate Type Default Rate Type.  If you use multicurrency accounting, you must 
select one of the rate types supplied with Sage 300, or add a new one.  

To view a list of defined rate types, click the Finder beside the Default 
Rate Type field, then double-click a rate type from the list. 

Gain/Loss Accounting Method.  When you select the Multicurrency 
option, you must also choose one of the following currency translation 
methods: 

• Realized and Unrealized Gain/Loss.  Exchange gains and losses 
resulting from fluctuating exchange rates are unrealized until 
transactions are settled. Outstanding balances in foreign currencies 
must be revalued at each balance sheet date at current rates. The 
resulting gains and losses are considered temporary, so they are 
not included in net income. Unrealized gains and losses are 
reversed in the next period. 

• Recognized Gain/Loss.  Exchange gains and losses are 
recognized when foreign currency monetary items are revalued or 
settled. These gains and losses are taken into income and appear 
on income statements for the current period.  
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Euro option Euro.  Select the Euro option if your functional currency is the euro, 
but your company wants to produce reports in the national currency of 
a member country of the EMU.  

Reporting currency Reporting Currency.  If you selected the Euro option, you must enter 
a currency code in this field. Reports will print in both the reporting 
currency and the euro. 

4. When you are satisfied with the company profile information, click OK. 

Sage 300 places icons for Administrative Services and Common 
Services on the company desktop. 

5. If you have not registered System Manager, the Unregistered 
Applications warning appears.  

a. Click OK to close the warning message.  

The Licenses form appears.  

b. Click the License Manager button, and then enter the required 
serial numbers, activation codes, and expiry dates (if applicable) 
on the licenses tab of the License Manager form. 

If you don’t have activation codes for the unregistered programs, 
click OK, and use the temporary licenses for the 30-day grace 
period. 

You can now activate your accounting applications, following the 
instructions in the next sections. 

Activating Your Data 
To activate Sage 300 applications: 

1. In the Administrative Services folder, double-click the Data Activation 
icon. 

2. When asked whether you are ready to proceed with activation, click 
Yes.  

A Data Activation form appears, listing applications that you can 
activate.  

3. Select the check box beside each application for which you want to 
activate data.  

The activation program automatically selects any applications that 
must be activated first, and then checks your data to ensure that it 
can activate them. 



Activating Your Data 

Installation and Administration Guide    4–9 

Most Sage 300 applications are interdependent. If you clear the 
selection for an application that others require, the activation program 
also clears the selection for the dependent applications. For example, if 
you clear the selection for Accounts Payable, but Purchase Orders and 
Project and Job Costing are selected, the program also clears the 
selections for Purchase Orders and Project and Job Costing. (For 
information about dependencies, see “Installing Sage 300” in Chapter 
2.) 

Note:  Sage 300 Options products are not part of the 
multi-application data activation. If you select Sales Analysis, Ops 
Inquiry, or a number change program, you are prompted to 
activate that program immediately. 

4. If the program displays a message saying that you cannot activate an 
application at this time: 

a. Close the Data Activation form. 

b. Correct the problems described in the error message. 

c. Reopen the Data Activation form, and continue the process. 

5. When you have finished selecting applications and entering required 
information, click the Activate button.  

The following form appears, showing the settings that will be used for 
any options that are required to activate a program: 

 

If you want to change any of the settings, double-click in the 
Value column for the program, and enter the correct value. 

If you are unsure about a setting, and prefer not to activate the 
program at this time: 

a. Click the Previous button.  
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b. Clear the check box for the program on the previous screen.  

c. Click Next when you are ready to proceed. 

6. To continue with the activation process, click Next. 

The following form appears, showing you the status of the applications 
you selected for activation: 

 

7. Click Activate. 

Depending on the number of applications you are activating, the 
process can take several minutes. The program displays a progress 
bar indicating the stage of completion, and updates the status of each 
activated program on the Data Activation form.  

8. When Activation has finished, click Close. 

Change the Administrator’s Password 
Sage 300 ships with a default password for the ADMIN user, allowing you 
to install and activate programs, and set up your databases. 

Once you finish activating Sage 300 programs, we recommend that you 
change the password for the ADMIN user to prevent unauthorized access 
to your company data.  

To restrict user access by password, you must first enable security for the 
system database, if you have not already done so. 
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To enable security for the system database: 

1. On the Windows Start menu, select All Programs > Sage 300 > 
Database Setup. 

2. In the Sign-On form that appears, type ADMIN for the password, and 
then click OK. 

The Database Setup form appears: 

 

3. In the Database Setup form, select the system database, and then 
click Edit to display the Database Profile. 

4. Select Enable Application Security, and then click OK. 

5. Click Exit to close Database Setup. 

Change the ADMIN Password 

You can change the ADMIN password from the Open Company dialog box 
by entering the ADMIN user ID, then clicking the Change Password 
button. (The button is available only if your system database uses 
security.) 

You can also change the password in the ADMIN user’s record once you 
open the company: 

1. From the Administrative Services folder, click the Users icon. 

2. Type the new password in the Password field, and then type it again in 
the Verify field. 

3. Click Save, and then click Close. 
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Where To Now? 
You can now: 

• Configure the Sage 300 web screens. 

For information on configuring the web screens, see Chapter 5, 
“Configuring Sage 300 Web Screens.” 

• Add users and set up security groups. 

For information on adding users and setting up security groups, see 
Chapter 6, “Performing Administrative Tasks.” 

• Set up accounting applications for your company. 

For guidance, refer to the help when setting up each application. 
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Chapter 5 
Configuring Sage 300 Web 

Screens 
 

Sage 300 web screens are modernized versions of the classic Sage 300 
desktop screens, which you use in a web browser. Web screens and 
desktop screens run in parallel. 

Important!  When using Sage 300 web screens over an external 
network or the internet, data must be protected with security 
measures such as Secure Socket Layer (SSL) or a Virtual Private 
Network (VPN). To determine appropriate security measures, 
consult with your information technology (IT) professional or Sage 
Business Partner. 

This chapter provides an overview of installing and configuring the 
Sage 300 web screens. It also provides steps for: 

• Configuring the portal database, which is required for web screens. 

• Adjusting certain settings configured during installation. 

Overview 
Before you can use Sage 300 web screens, you must: 

1. Install the current version of Sage 300, including the web screens. For 
details, see Chapter 2, “Installing Sage 300 Programs.” 

2. Activate your company data for the Sage 300 programs you use. 

3. Create a portal database, which stores files used by the Sage 300 web 
screens. Normally, you create this database on the same server as 
your Sage 300 data. For information about creating databases, see 
Chapter 3, “Database Setup.” 

If you create the portal database using SQL Server Express, you will 
need to configure a TCP/IP connection manually in that program. For 
more information, see, “Configuring a Microsoft SQL Server Express 
Database,” later in this chapter. 

4. Configure the Sage 300 web screens, as described in this chapter. 
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Configuring Security for Web Screens 
This section outlines some security precautions you should take if you are 
setting up web screens to be accessible from the Internet. 

IMPORTANT This section is not a comprehensive discussion of security. Make 
sure you also consult any documentation you have regarding security for 
your specific system (in particular, the documentation for your version of 
IIS). If you have any concerns about security, contact your Sage business 
partner or IT professional. 

At a minimum, you should take the following security precautions: 

IIS: 

• Configure the web screens to use HTTPS: 

a. Purchase an SSL certificate from a reputable supplier. 

b. Turn on HTTPS by adding an HTTPS binding (in the binding you will 
specify your SSL certificate). 

c. Turn off HTTP by selecting the Require SSL option. 

Note:  When you turn on HTTPS, all URLs for web screens are 
changed to begin with https instead of http. This invalidates 
any existing links to web screens. 

• Disable or remove the default IIS file from the web server. 

• Remove sensitive information from HTTP Response Headers. At a 
minimum, install the URL Rewrite module and add a rule to remove 
server information from all responses. 

• Disable any encryption algorithms with a symmetric key shorter than 
128 bits. 

• Disable weak SSL Cipher Suites from publishing on the internet for all 
external systems. 

• Disable insecure HTTP methods (at minimum, TRACE). 

• Disable Directory Browsing for all virtual directories. 

Passwords: 

Use Advanced Security Settings in Sage 300 to enforce a strong password 
policy: 

• Require complex passwords (passwords that must include letters 
and digits). 
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• Specify a length of time after which users must change their 
passwords. 

• Require a minimum password length of at least 8 characters. 

• Lock out users after multiple failed login attempts. 

Other: 

• Secure Sage 300 databases. 

• Secure shared folders. 

• Run Windows Update. 

• Turn off services you don’t need. 

• Use a firewall. 

Configuring the Portal Database 
Before you can configure the web screens, you must create and then 
configure a portal database. For information about creating databases, see 
Chapter 3, “Database Setup.” 

Note:  The portal database is shared by all companies in a Sage 300 
installation, so you need to configure only one portal database. 

To configure the portal database: 

1. From the Windows Start menu, select All Programs > Sage 300 > 
Database Setup. 

2. On the Sign-On form that appears, enter the ADMIN password. 

3. On the Database Setup form that appears, click Portal. 

4. On the Configure Portal form that appears, enter the following 
information: 

• Database Format.  Microsoft SQL Server is the only database 
engine you can use to create your portal database. 

• Server Name.  By default, this is set to “localhost” to use the 
current machine. If you created your portal database on a different 
(remote) machine, enter the name of that machine. 

Note:  If multiple instances of Microsoft SQL Server are installed on 
the same machine, you can specify an instance by entering the 
server name in the format servername/instancename. 
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• Server Port.  Enter the TCP/IP port number specified in your 
database software for your portal database. The default port 
number is 1433. 

• Database ID.  Enter the name specified for the portal database in 
your database software. 

• Login ID and Password.  Enter the ID and password specified for 
your database administrator in your database software. (They are 
not the credentials for the Sage 300 ADMIN User.) 

Note:  You must supply credentials for SQL authentication. The 
portal database does not support Windows authentication. 

5. Click OK, and then click Exit to close the Database Setup form. 

If you set up the portal database using SQL Server Express, follow the 
steps in the next section, “Configuring a Microsoft SQL Server Express 
Database.” 

Configuring a Microsoft SQL Server Express Database 

The following instructions apply only to Microsoft SQL Server Express. 

In SQL Server Express, the default TCP/IP connections settings are 
disabled. Because the portal database requires a TCP/IP connection, you 
must set one up manually, as follows: 

1. Launch the SQL Server Configuration Manager. 

2. Under the SQL Server Network Configuration tree, click Protocols For 
SQLEXPRESS. 

3. Enable the TCP/IP protocol. (The default setting is Disabled.) 

4. Right-click the TCP/IP protocol, and then click Properties. 

5. On the IP Addresses tab, in the IPAll Section: 

a. Clear the TCP Dynamic Ports field. 

b. Set the TCP Port to 1433. 

6. Restart the SQL Server. 

Testing the TCP/IP Connection 

To test that TCP/IP works, from the command line, type: 

telnet localhost 1433 
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If the TCP/IP connection is set up correctly, the screen will clear, and you 
will be in a Telnet session with the SQL Server. 

Configuring English Windows to Display Chinese 

If you work with Chinese language packs and the portal machine uses 
English Windows, you must configure Windows to display Chinese 
properly. 

To configure English Windows to display Chinese: 

1. On the machine where the portal database is installed, click Start > 
Search Programs And Files, and then type intl.cpl. 

2. On the Regional And Language screen, select the Formats tab.  

3. For the Format option, select Chinese (Simplified, PRC), if it is not 
already selected, and then click Apply. 

Alternatively, you can select Chinese (Traditional, Taiwan) or 
Chinese (Traditional, Hong Kong S.A.R.) for Traditional Chinese. 

4. Click the Administrative tab, and then: 

a. Click Copy Settings. 

b. For the Copy Your Current Settings To option, select Welcome 
Screen And System Accounts. 

c. Click OK. 

d. Click Change system locale. 

e. For the current system locale, select Chinese (Simplified, PRC), 
if it is not already selected. 

f. Click OK. 

5. When prompted to restart the machine, click Restart now. 

Setting Up a User Account for IIS and Windows 
Services 

By default, the Sage 300 application pool in IIS and the 
Sage.CNA.WindowsService Windows service run under the Local System 
account. To simplify service management, improve security, and support 
consistent handling of regional settings and content in Sage 300 web 
screens, we recommend you set up a Windows user account and modify 
the application pool and Windows service to run under that user account.  
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The user account must have access to the Sage 300 shared data folder 
and customization directory. Also note that the account’s regional settings 
determine the language in which some content appears in Sage 300. 

Starting the Sage 300 Web Screens 
Once you have configured the Sage 300 web screens as described in this 
chapter, they are ready to use. 

To open web screens in a browser: 

1. Visit http://servername/sage300, where servername is the server 
name or IP address of the server where Sage 300 is installed. 

2. Enter your username and password. 

3. Select a company. 

4. Click Sign In. 



Installation and Administration Guide    6–1 

Chapter 6 
Performing Administrative Tasks 

 

The procedures in this chapter are relevant to all Sage 300 configurations. 

Perform these procedures at any time after you have installed Sage 300 
programs. Sign on as the ADMIN user at any server or workstation that 
runs Sage 300.  

This chapter describes how to: 

• Create user records 

• Set up optional security groups  

• Assign user authorizations 

Add Users 
For each user, assign an ID and set up individual security options.  

1. In the Administrative Services folder, double-click the Users icon. 

2. In the User ID field, use up to eight characters to type a unique code 
to identify this user (letters from A to Z and digits from 0 to 9). The ID 
must start with a letter, not a number.  

 New button If the ID field is not blank, click the New button to start a new record. 

When security is turned on for the system database, the User ID 
determines user’s access rights in Sage 300. 

3. In the User Name field, type a name for this user. 

4. In the Account Type field, select User or Timecard.  

Note:  If you select Timecard, you must create a security group for 
employees who only enter timecards, later. 

5. Select the language in which to display and print this user’s messages, 
Help, reports, and forms. 

Note:  If you use Sage 300 web screens, users may need to select 
this language in their web browser settings as the preferred 
language for viewing web pages. 



Add Users 

6–2    Sage 300 

6. In the Authentication Method field, select one of the following options 
that determines how this user will sign on to Sage 300: 

Sage 300 — allows the user to sign on using only their Sage 300 User 
ID. 

Windows — allows the user to sign on using their Windows User ID. 

Both — allows the user to sign on using either their Windows User ID 
or their Sage 300 User ID.  

7. In the Job Role field, select the role that most resembles this user’s 
job role. If you leave this field blank, the user is prompted to select a 
role when they sign in to Sage 300. 

8. If you chose Windows or Both as the authentication method, enter a 
Windows Domain name and the Windows User Name for this user in 
the fields provided.  

You can click the Browse button to select from a list of Windows users 
and domains. 

If you selected Sage 300 as the authentication method, these fields 
are not available. 

9. If you chose Sage 300 or Both as the authentication method, type a 
password in the Password field, and then type it again in the Verify 
field.  

The password can use between 4 and 64 characters (letters from A to 
Z and digits from 0 to 9), but it must start with a letter.  

When you type a password, Sage 300 displays asterisks. You must 
enter a password in each user record. However, if security is not 
turned on for the system database that the company uses, users are 
not asked for the password when they start Sage 300. 

Note:  Users must use a password to open Sage 300 using their 
browsers. 

10. Assign additional security to the password, selecting from the following 
options:  

User Must Change Password At Next Logon — forces the user to 
change their password the next time they sign on to Sage 300. This 
option is not available if you selected Windows as the authentication 
method. 

User Cannot Change Password — prevents a user from changing 
their password. This option is not available if you selected Windows as 
the authentication method. 
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Password Never Expires — allows the same password to be used 
without requiring a change. This option is not available if you selected 
Windows as the authentication method. 

Account Is Disabled — prevents a user from signing on.  

Account Is Restricted — restricts the user to signing on to Sage 300 
only during the valid times that you specify.  

Account Is Locked Out — locks out the user after they exceed the 
maximum number of attempts specified in the advanced security 
settings for the system database. The system assigns this status, and, 
depending on the security settings, can clear this status after a certain 
period. The ADMIN user can also clear this status.   

This option is not available if you selected Windows as the 
authentication method. 

11. If you selected the option to restrict the user’s account, in the Valid 
Times section, specify the days of the week and the hours that the 
user can sign on to Sage 300. 

12. In the Contact Information section, enter e-mail addresses and a 
phone number for this user. 

13. Select the User receives e-mail from Sage with information 
relevant to job role option to indicate that this user consents to 
receive e-mail from Sage. 

Note:  If this option is selected, you must enter information in the 
Job Role and E-mail 1 fields. 

14. Click Add to save each new user record.  

Using Windows as the Authentication Method 

If you select Windows as the authentication method for a user, the user 
must sign on to Sage 300 with a valid Windows user ID.  

Normally, when a user signs on to Windows with their user name, domain, 
and password, the server uses this information to authenticate the user. If 
the user then signs on to Sage 300 with the same ID and domain, they do 
not need to provide a password. 

Note: The administrator must first map the Windows password to 
the Sage 300 user ID. (See Windows’ documentation for 
instructions.)  
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The following fields are not available in the User record when you select 
Windows as the authentication method: 

• Password and Verify 
• User Must Change Password At Next Logon  
• Password Never Expires 
• User Cannot Change Password 

If you are changing the authentication method for an existing user, any 
previously assigned passwords are cleared, and therefore no longer valid. 

Signing On to Sage 300 with Windows Authentication 

Changes to the 
Open Company 
dialog box 

To allow Windows authentication, the Open Company dialog box includes: 

• A Windows Authentication check box.  

• A field for the Windows Domain name. (This field appears only if the 
particular user’s record specifies Windows authentication.) 

If the Sage 300 authentication method is assigned to all users, the Open 
Company dialog box displays the Windows Authentication check box, but 
it is not available to any users, including the ADMIN user, from the 
Sage 300 desktop. 

Sage 300 
Authentication 
Method 

 

If the Windows or the Both authentication methods are assigned to any 
user, the Windows Authentication option is available, but not selected, for 
all users, as shown here:  

Windows / Both 
Authentication 
Methods 

 

When a user selects the Windows Authentication option, the Domain field 
appears, as follows:  

Windows 
Authentication 
option selected, 
Domain field 
displayed 

 

Option enabled 

Option disabled 
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By default, the Domain and User ID fields display the domain and user ID 
for the currently logged-in Windows user, if their Sage 300 User ID has 
been mapped to a Windows user account.  

Password fields 
disabled 

The Password field and the Change Password button are always disabled 
for Windows Authentication. 

Signing On to Sage 300 if “Both” is the Authentication Method 

The Both authentication setting allows a user to sign on to Sage 300 using 
either their Sage 300 ID and password or their Windows User ID. 

Set Up Security Groups and Assign User 
Authorizations 

If the Security option is selected for a system database, access to 
Sage 300 is restricted by password for all companies that share the 
system database. 

If security is turned on, or if some users have a Timecard account, users 
require authorization to perform tasks in each Sage 300 program. You 
provide this authorization by assigning users to security groups. 

When you create security groups, you specify the tasks that each group 
can perform. All companies using the same system database share 
security groups.  

Create Security Groups 

You create security groups, as follows: 

1. In the Administrative Services folder, double-click the Security Groups 
icon.  

 

2. Select an application from the Application list.  
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3. Enter a unique group ID and a description.  

The group ID can be up to eight characters (letters from A to Z and 
digits from 0 to 9).  

4. Select the tasks the security group can perform. 

• To select every task in the list, click Select All. 

• To remove a task that has already been selected, click the check 
box to clear it. 

• To remove all tasks, click the Remove All button. 

5. Click Add.  

6. Repeat these steps for each application.  

Now, you can assign users to these security groups, as described in the 
next section. 

Authorizing Users 

You assign each user to one security group for each application. All users 
in the same group can perform the tasks defined for the group. The same 
user can be assigned to different groups within the same company. 

To assign user authorizations: 

1. In the Administrative Services folder, double-click the User 
Authorizations icon.  

The User Authorizations dialog box appears: 

 

2. Select the User ID. 

If a security group has been assigned to this user, it appears next to 
the Application name, in the Group ID column. 
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3. For each application to which you want to allow access for this user: 

a. Double-click the Group ID field to display a Finder button.  

b. Click the button to display security groups defined for the 
application.  

c. Select a security group from the list.  

4. Repeat steps 2 and 3 for each user.  

5. When you have finished assigning security groups to all users, click 
Close. 

Create and Assign UI Profiles for Customized User 
Interface Forms 

If your users do not need to use all fields in dialog boxes and forms, you 
can customize their user interfaces, hiding some fields.  

To create a UI Profile ID: 

1. Determine the fields a user will not need when using certain forms and 
dialog boxes.  

2. Open Sage 300 as the ADMIN user. 

3. Create your User IDs. (See previous sections for the steps.) 

4. Open the form that you are customizing for a user. (In our following 
examples, we chose Currency Codes.)  

5. Choose Customize from the File menu. 

The Customize form for Currency Codes looks like this: 

 

The Customize screen displays a list of the controls that can be hidden 
for the dialog box or form that you started from (for our example, the 

Field controls that 
can be hidden 



Create and Assign UI Profiles for Customized User Interface Forms 

6–8    Sage 300 

Currency Codes dialog box). To hide some of these controls for users, 
you must either select an existing profile or create a new one. In the 
following steps, we explain how to create a new profile. 

6. Click the New button beside the Working Profile field. 

The following screen appears: 

 

7. Enter a unique ID, using up to 20 characters, in the Profile ID field (for 
example, CURRCODE), and a description in the Profile Description 
field, then click Add, then click Close to return to the Customize form.  

The Customize form will now look like this:  

 

Because we have just created the first Working Profile, it is selected in 
the Working Profile field. We must now clear the controls that we do 
not want the user to see in the Currency Codes dialog box. 
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8. Click checkmarks beside the controls for the fields to hide. The 
checkmarks disappear, as shown next: 

 

The field will be hidden when users assigned to the CURRCODE 
Working Profile open the Currency Codes dialog box. 

9. Click Save, then click OK to return to the dialog box you customized. 
(In our example, we return to Currency Codes.)  

10. Click Close in the dialog box. 

After creating a UI Profile ID, you assign users to it. You can create as 
many Profiles as you need, and assign each user to a different Profile. You 
can assign more than one user to each Profile ID. 

To assign Users to Profile IDs: 

1. Double-click the Assign UI Profiles icon in the Administrative Services 
folder.  

If you have not assigned any UI Profiles to users, the Assign UI Profiles 
form has no entries in the grid, as shown below: 

 

 

 

Field to be hidden 
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2. Click the Finder in the User ID column, highlight a User ID from the 
list, and click Select.   

 

The Assign UI Profile form reappears, with the selected User ID 
displayed in the User ID column. 

 

3. Click the Finder in the Profile ID column to choose a Profile from the 
list.  

Our sample Assign UI Profiles form now displays the following: 

 

Each time you open the Assign UI Profiles screen, the grid displays all 
User IDs and Profile IDs previously assigned. 

4. Click Close to return to the Sage 300 desktop. 

The next time the selected user opens the form that has been restricted, 
the fields hidden in the Working Profile will not appear. 
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Set Up Customization Directories 
If a user or group needs to print customized Sage 300 reports, you should 
set up customization directories to store the customized reports.  

Note that: 

• Only the ADMIN user can create customization directories. 

• SAP Crystal Reports® for Sage 300 is required to customize or create 
new reports. 

Remove Sage 300 Programs 
To remove Sage 300 programs: 

1. In Windows’ Control Panel, click Programs And Features. 

2. Open Uninstall Or Change A Program, and then: 

− To remove all Sage 300 programs, double-click your Sage 300 
version. 

− To remove individual Sage 300 programs: 

i. Click your Sage 300 version, and then click Change. (Do not 
double-click.) 

ii. Click Modify, and then use the Select Features screen to select 
the programs you want to install and clear the selections for 
programs you want to remove. 
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Chapter 7 
Licensing Sage 300 

 

This chapter provides information about perpetual licenses for Sage 300. 
If you have a subscription license, you do not need to read this chapter. 

In this chapter, you’ll learn how to: 

• View or update license information for your Sage 300 installation. 

• Enter activation codes for installed Sage 300 accounting programs. 

• Enter activation codes for user LanPaks, and for Report Manager and 
Report Viewer for Sage 300 Intelligence Reporting. 

Licensing Products and Users 
Each Sage 300 product license allows a company to use a particular 
version of a Sage 300 program. You require a new license whenever you 
install a new Sage 300 program or upgrade to a new version.  

During installation, the program creates temporary license files (with 
serial number “000000000000”) for Sage 300 programs. These temporary 
licenses let you use Sage 300 for 30 days, while you wait for activation 
codes from Sage.  

Until you enter activation codes, whenever you sign on to your company 
database, Sage 300 will display an Unregistered Applications message to 
remind you to register the programs. 

Once you receive valid serial numbers and activation codes, you enter 
them in the License Manager to make the licenses permanent. 

You require a 
LanPak license to 
use Sage 300 

Installation does not generate temporary LanPak licenses, however. 
LanPak is Sage 300’s user licensing system. Without a LanPak license, no 
one — including the ADMIN user — can sign on to a company. 

Normally, you enter the activation code for your LanPak license as part of 
program installation. (When the installation program finishes, it displays 
the License Manager, where you enter the activation code for your LanPak 
on the Users tab.) 



Creating a Temporary LanPak License 

7–2    Sage 300 

Note:  You register a license for a particular company in 
combination with a product serial number. If your company 
changes its name (for example, after a merger), you need to 
update the licenses for all your Sage 300 products. 

After you change the company name in the License Manager, the 
activation code will be marked Unauthorized. The license will 
remain valid, but you should apply for another activation code for 
the new company name. 

The following sections describe LanPak licenses in more detail, and explain 
how to create a temporary LanPak license if you did not enter an 
activation code for a LanPak when you installed Sage 300. 

LanPak Licenses 

A LanPak license regulates how many users can work with a particular 
version of Sage 300. The number of LanPak licenses you require depends 
on the number of workstations on which you install Sage 300 and the 
number of users who will access company databases on those 
workstations. 

• To use Sage 300 on a single computer, you must register a 1-user 
LanPak. (With this type of LanPak, you cannot work with two Sage 300 
databases at the same time.) 

• To add Sage 300 users to a network, you register multi-user LanPaks. 
You can obtain LanPak licenses for any number of users on a network. 

Note:  One LanPak is required for each user that opens a Sage 300 
database from a workstation. A user can open multiple databases 
from the same workstation providing they use the same Windows 
user profile.  

Creating a Temporary LanPak License 
Before you can begin using Sage 300, you must register a LanPak license 
for a specific number of users. If you do not yet have an activation code 
for your LanPak license, you can create a temporary LanPak license that 
will allow you to begin using Sage 300. 

To create a temporary LanPak license: 

1. In the Licenses form, click License Manager.  
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2. Click the Users tab, and then click in the blank space to create a new 
line. (If there are existing lines, right-click in the blank space, and 
then click Insert.) 

The Users tab should now appear as follows: 

 

3. In the new line: 

 a. Click the License Type column, and then select LanPak from the list 
that appears. 

b. Click the Count column, and then enter the number of users that 
require concurrent access to Sage 300. 

 

4. Click Close, and then click OK.  

You can now open the company. 
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Requesting Activation Codes 
 You need activation codes to use Sage 300 products, including upgrades. 

However, you can run Sage 300 for up to 30 days while you await your 
activation codes.  

You can obtain activation codes from the Sage Customer or Partner Portal. 

If you are a Sage customer: 

1. Log in to your account at 
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 

If you don’t have an account, use the self-registration tool on the 
Customer Portal login page to create one. 

2. On the Support menu, click Self Service. 

3. Click the My Products tab. 

4. Follow the instructions on the My Products tab to display and print the 
Details Sheet. 

If you need assistance with the Customer Portal, e-mail 
Customer.Portal@sage.com, or call 1-877-828-6372. 

If you are a Sage partner: 

1. Log in to your account at 
https://partners.sagenorthamerica.com/irj/portal. 

If you don’t have an account, contact the portal administrator at your 
company, or contact Sage. 

2. Click Customers > Details Sheet. 

3. Click Show Advanced Search. 

4. Enter an account ID, and then click Go. 

5. On the Details Sheet, click the Products Details tab to view the 
customer’s activation codes. 

If you need assistance with the Partner Portal, e-mail 
Partner.Portal@sage.com, or call 1-877-828-6372. 

https://customers.sagenorthamerica.com/irj/portal/anonymous/login
mailto:Customer.Portal@sage.com
https://partners.sagenorthamerica.com/irj/portal
mailto:Partner.Portal@sage.com
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Updating Your Sage 300 Licenses 
You use the License Manager to: 

• View license information for your Sage 300 programs, including the 
number of users authorized by the LanPak license. 

• Enter serial numbers, activation codes, and expiry dates (if applicable) 
for the Sage 300 programs and services that your company is using.  

• When necessary, change the company name to which your Sage 300 
software is registered (for instance, after a merger). 

The License Manager form appears during program installation, letting you 
enter serial numbers, activation codes, and expiry dates (if applicable) for 
any new Sage 300 programs and LanPaks that you are installing.  

During installation, the program creates temporary license files (with 
serial number “000000000000”) for Sage 300 Programs. If you have 
received valid serial numbers and activation codes, you enter them in the 
License Manager to make the licenses permanent. 

You can also open the License Manager, later, if you need to add or 
change any licensing information. If you don’t enter LanPak information 
during installation, for example, the program prompts you to enter it in 
the License Manager form. 

To update product licenses or LanPaks: 

1. From the Help menu on the Sage 300 desktop, click Licenses. 

2. On the Licenses form that appears, click the License Manager button. 

• To edit the client ID, Licensed To (person or entity), dealer, 
and CC (certified consultant or business partner), click the 
License Information tab.  

If you need to change the company name to which your Sage 300 
software is registered, you click the Change button, and then type 
the new name in the Company field. When you next open the 
License Manager form, the company field will be disabled, unless 
you click Change again. 

Note:  Activation codes are effective for serial numbers and 
company names used together. After you change the company 
name, the activation code will be marked Unauthorized. The license 
will remain valid, but you should apply for another activation code 
for the new company name. 
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• To enter activation codes for your Sage 300 products (for 
example, to update a temporary license with a permanent one), 
click the Licenses tab.  

You must enter the Serial Number and the Activation Code, in 
order, for each Sage 300 product you want to register:  

i. Click in the Serial Number column, and then type your serial 
number for the selected product. 

ii. Click in the Activation Code column, and then type the 
activation code for the product. 

Note: You require permanent licenses for the Analysis and 
Connector modules for Sage 300 Intelligence Reporting. No 
temporary licenses are available for these programs. 

• To enter activation codes for LanPak licenses, or to delete 
temporary licenses for databases that you do not use, click 
the Users tab. 

You must enter information for each LanPak user in this order:   

 i. Click in the License Type column, and then select LanPak. 

ii. Click in the Count column, and then enter the number of users 
that require concurrent access to Sage 300. 

iii. Click in the Serial Number column, and then type your serial 
number for the selected product. 

iv. Click in the Activation Code column, and then type the 
activation code for the product.  

Note: You also use this tab to record activation codes for additional 
licenses for the Report Manager and the Report Viewer in single-
user increments. (One Report Manager license — for one user — is 
free with Sage 300.) 

3. When you have finished entering information, click Close to return to 
the Licenses form. 

4. Click OK to return to the desktop. 
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Viewing License Information  

You use the Licenses form to view Sage 300 licenses, as follows: 

On the Sage 300 desktop, from the Help menu, click Licenses. 

 

Viewing details for 
a single license 

• To see information for a single license, select the product on the list, 
and then click the License Info button (or double-click the product 
name). 

Viewing details for 
LanPak and IAP 
license use 

• To see information about users currently signed in to Sage 300, 
including third-party products you are using that integrate with Sage 
300, click the Current Users button. 

Updating product 
or LanPak licenses 

• To see details for all Sage 300 licenses and LanPaks, or to update 
licensing information, click the License Manager button. 

Monitoring LanPak Activity 
The Current Users screen lists all users currently signed in to Sage 300 
with a LanPak or IAP license. It also displays information about user 
activity, such as a list of screens each user has open. 

To open the Current Users screen, click Current Users on the Sage 300 
desktop Help menu. 
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